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Introduction 

The Adobe¨ InDesign¨ CS3 3 Classroom in a Book™ 
course presents students with tips, techniques, and 
solutions for using the Adobe InDesign CS3 software. 
The Instructor Notes are intended to complement the 
information in the Adobe InDesign CS3 Classroom in a 
Book¨. 

The information is organized to follow the sequence of 
instruction in each lesson. 

About the Workbooks 

It is recommended that each student in the class have an 
individual copy of the Adobe InDesign CS3 Class room 
in a Book. Students will use this book as you lead them 
through projects. Additionally, the book can be used as a 
self-paced tutorial. 

Course Strategy 

If you’re teaching a 13-session class, you can teach 
approximately one chapter of this book per class. The 
book contains 14 lessons (including the Quick Start 
lesson), some of which may take a while to complete. 
If you are teaching a 10-session class, you may want 
to combine some of the lessons in a single class. For 
example: 

Lessons 4 and 5 and 7 are focused on different  •
aspects of working with importing and 
formatting text.

Lessons 3 and 8 are both focused on working  •
with graphics and frames.

The following lessons cover enhanced or new features in 
InDesign CS3: 

Lesson 1 covers the new interface, streamlined  •
across the Adobe Creative Suite 3 products, and 
illustrates the updated workspace and panels. 

Lesson 3 details enhancements to fitting  •
frames to content as well as alignment options 
including aligning objects to the page. 

Lesson 7 covers the new table and cell styles  •
features. 

Lesson 10 shows new effects and transparency  •
options that can be applied to and shared 
between objects.

We recommend that, at an absolute minimum, you 
teach Lessons 1 through 8. The majority of the most 
basic Adobe InDesign features and the InDesign work 
environment are covered in these lessons.  How ever, 
completing all the lessons through Lesson 9 and including 
Lesson 12 would make a far superior introduction. Before 
begin ning a lesson, encourage students to browse through 
it, and read any sidebars



Managing Student Projects 

One way to simplify file storage and retrieval in class room 
situations is to ask students to create a folder on their 
hard disks, name it [Student’s, for the student’s name] 
Lessons, and then copy each project folder into the main 
Lessons folder. Having students keep all their working 
files in their own Lessons folder makes it easy for you to 
clean up files when a class is over. 

Additional Resources 

Instructors and users of Adobe InDesign rely on a variety 
of resources to supplement their knowledge of the 
program. You may find the following resources useful to 
explore: 

InDesign Help: The Help installed with InDesign 
contains a complete descriptions of all fea tures, including 
topics not covered in the User Guide. It also contains 
links to movies that showcase new CS3 features, and 
techniques for using the software. 

Adobe InDesign CS3 User Guide: This guide, a 
subset of Help, contains feature descrip tions. It’s useful 
for learning about areas of the program that are outside 
the scope of the Classroom in a Book. Printed copies of 
Adobe InDesign CS3 documentation are available for 
purchase from www.adobe.com/go/buy_books.

Application DVD: The Adobe InDesign CS3 
application DVD contains the Adobe Press folder, the 
Adobe Certified folder, lesson files, Adobe Design Center 
info, and movies. 

Adobe CS3 Video Workshop DVD: Included in 
the product box, this DVD provides lots of in structional 
movies on InDesign CS3 and other prod ucts across the 

Adobe Creative Suite 3 lineup.

Adobe Web site

The U.S. Adobe Web site at www.adobe.com contains 
a variety of InDesign training and support resources, 
including the Adobe Design Center for InDesign. 

Many step-by-step tutorials, galleries, and other resources 
are available at the Adobe Web site, and the User-to-
User Forums are a great place for students to learn from 
more experienced users. Adobe Design Center provides 
hundreds of tutorials from experts and authors in the 
community, as well as thoughtful articles about design 
and technology. 

Go to: www.adobe.com/designcenter/.

Adobe Certified Expert (ACE) program 

This program is designed to validate an expert skill level 
of Adobe InDesign CS3. Careful testing of can didates 
ensures that each ACE has demonstrated expert product 
knowledge of the current release of Adobe InDesign, 
resulting in increased marketability and an added 
credential. Training for the ACE program is available 
through Adobe Authorized Training Center (AATC) and 
self-study. 

For more information about this program, send an     
e-mail to certification@adobe.com or visit the Adobe Web 
site at:  http://www.adobe.com.
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Lesson 1: Getting to Know the Work Area
This lesson provides an overview of the functionality 
of InDesign. By the end of this lesson, students should 
understand that they can use InDesign to create page 
layouts using a variety of elements. They should also 
understand the overall interface of InDesign, including, 
how to access panels, where tools are located, and how 
objects are placed inside of frames. 

Working with the Tools panel 

Pages 49–52: Note that many of the tools have pop-
up options. Tools you need to access may be hidden 
beneath other tools. A complete listing of all the tools, 
including available selections from each tool group, is 
provided on page 49. Also, many tools have keyboard 
shortcuts that you can use to quickly activate them. These 
are listed adjacent to the tool name in the graphic on this 
page. 

New Window 

Page 55: It is important to note that new windows are 
not the same as new documents. You can create multiple 
views of the same document, opening new windows as 
necessary. Each window is simply a separate view of the 
same document. 

Panels 

Page 56: All panels are organized under the Window 
menu. Your students should never be lost looking for 
panels once they understand this key concept. 

Working with Panels

Page 58: Panels and the workspace in general have 
undergone a lot of change in CS3. Working with the 

panels by minimizing, collapsing to icons and more are 
very important in order to work efficiently in InDesign. 
Getting students to open, close and dock panels will be 
very beneficial. Allow students to explore by docking and 
collapsing panels in other groups as well as on the left side 

of the workspace.

Customizing your Workspace 

Page 61: If you have multiple groups of students using 
the same computers, you can have each student create 
and save their own workspace. You can also have them 
restore a default workspace if needed.

Zooming 

Page 64: While the Zoom tool works well, you can 
work more efficiently by holding down the modifier keys 
to temporarily activate the Zoom tools. Use Command 
+ Spacebar (Mac) or Ctrl + Spacebar (Windows) to 
temporarily activate the Zoom tool, which allows you to 
quickly increase your magnification without having to 
switch tools. 

Scrolling 

Page 70: Use the space bar to temporarily activate the 
hand tool to scroll through a document. When entering 
text, using the Alt (Windows) or Option key (Mac OS) to 
temporarily access this tool, rather than needing to switch 
using the Tools panel. Another shortcut option is to 
simply use Alt+Spacebar (Windows) or Option+Spacebar 
(Mac OS) any time, no matter what context.

Context Menus 

Page 73: Context menus are widely used throughout 
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InDesign. Use your right mouse button to access these 
throughout InDesign. You’ll find these helpful menus let 
you avoid the need to remember a large number of key 
commands or frequently search for items in the menus. 

Help

Page 75: Encourage students to actively use the 
InDesign Help Center. It has a wealth of program 
information and the topics are easily divided into 
understandable categories.

Questions 

How can you organize your panels?1. 

If you are looking for a tool and it is not visible, where 2. 
might it be located? 

Answers 

You can create custom groups of panels by moving 1. 
them into their own panels. You can also create your 
own custom workspace. 

Some tools are nested, as they are located behind 2. 
other tools. You must click and hold down on a tool 
to select any tools that are nested behind it. 
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Lesson 2: Setting Up Your Document
This lesson provides the foundation for creating new 
documents. This lesson is focused on how to create 
custom page sizes, defining a master page, and applying 
master pages to a document page. 

Creating and Saving Custom Page 
Settings 

Page 82: You are not required to create a document 
preset before creating a new document. You should create 
these only if you will be frequently re-using custom page 
settings such as bleed and page size.

Master Pages 

Page 85: Understanding of master pages is critical for 
anyone who will be creating longer documents. They 
avoid repetitive formatting tasks, and are widely used by 
anyone creating longer documents. 

Guides 

Pages 86–89: You can place guides on either 
document or master pages. All guides can be edited on 
document pages, whether they are page guides, ruler 
guides, margins, or columns. It is not necessary to edit 
them on the master page if they only need to be modified 
in one instance on a specific document page due to a 
specific, unique page layout.  
 
Notice that when a guide is placed on a master page that 
it is not editable (you cannot select it) on a regular page 
in your document. Students may either need to break the 
master link to the guide or edit it on the master page.

Placeholder Frames 

Page 94: It is not necessary to create placeholder 
frames before importing objects. While this lesson uses 
a foundation of placeholder frames to create a consistent 
layout, you can also create the frames at the time you 
import graphics and text. 

Text Linking 

Pages 102-103: This is another key concept, as any 
document that has text running from one page to another 
will need to use links. Be certain that your students 
understand this concept before moving into other longer 
documents.

Adding Pages 

Page 107: As an alternate, you can drag master pages 
from the top of the Pages panel to the bottom of the panel 
to add pages into a document. Students may also wish to 
use the menu item Layout > Pages > Insert Pages as an 
alternative.

Placing Text and Graphics

Page 108: When students attempt to place the palm 
tree image, in step 3, it may prove difficult. Tell students 
to watch the cursor (the loaded picture icon) to tell when 
to place the image. If they click too low on the graphics 
frame, they will place the picture in the text frame that is 
on top of it on the master page. Tell them to click on the 
very top portion of the graphics frame where it doesn’t 
overlap the text frame. Edit > Undo can pull the graphic 
out of the frame if they choose the wrong one!
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Eyedropper tool

Page 112: The Eyedropper can be tricky. Make sure 
that the students select the correct text and the Fill of the 
text otherwise problems may arise.

Questions 

When are master pages most useful? 1. 

Where can you create guides that will appear on all 2. 
pages? 

How can you avoid repetition when creating 3. 
documents that will all be the same size? 

Answers 

When you have long documents with repetitive 1. 
formatting, such as running headers, running footers 
or a consistent layout used on a number of pages. 

You can create a master page with guides. 2. 

You can create a Document Preset or you can create a 3. 
template document.
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Lesson 3: Working with Frames
This is an important chapter, as all objects are placed 
within frames. Text, graphics and even tables are placed 
inside of frames. So getting familiar with how they 
operate enables your students to more efficiently work 
with both text and graphics. 

Working with Layers

Pages 119-122: Layers are another key concept. 
These pages take students through the basics of layers 
and make them aware of what layer they are working on 
at any moment. If layers are initially setup, they are too 
easily forgotten about later when design or production 
begins. 
 
One thing that continually trips students up is a locked 
layer. Looking to the Layers panel for locked layers is 
another place to look when an object cannot be selected 
(like a master item).

Fitting Frames

Page 123, step 4: New in CS3 is the ability to fit 
frames to content by double-clicking on a frame handle. 
Allow students to practice with text and pictures and 
double-click on different frame handles to see different 
results (especially with pictures).

Select and Direct Selection tools 

Page 125: It is important to understand when to use 
the Selection tool as opposed to the Direct Selection when 
looking to manipulate a text frame. Use the Selection tool 
to move text and frame together, while you use the direct 
select to manipulate the anchor points of the frame. It’s 
easy to forget which tool you are currently using.

Frames 

Page 130: Remember that frames placed on document 
pages let you place either text or graphics into them, so 
the tools you use to create frames on document pages are 
quite flexible. 

Duplicating Objects 

Page 131: You can hold down the Alt (Windows) 
or Option (Mac OS) key while dragging an object to 
duplicate it, or you can also use the Step and Repeat 
command if you need to create multiple objects. Of 
course, copy and paste also works. 

Resizing a Graphics Frame (cropping)

Page 132: Changing the crop of an image does not 
change the image itself. The visible area is all that is 
changed. 

Select and Direct Selection Tools 

Page 132-133: It is important to understand when to 
use the Selection tool as opposed to the Direct Selection 
when looking to manipulate the location of an image. Use 
the Selection tool to move an image and frame together, 
while you use the direct select to manipulate the content. 

Changing the Shape of a Frame

Page 137, step 6: When students attempt to 
manipulate the upper-right corner of the frame, make 
sure that only the upper-right point is selected. This may 
require clicking off of, then on the upper-right corner 
point with the Direct Selection tool.



 LessoN 3 9 
 ADOBE INDESIGN CS3 CLASSROOM IN A BOOK

Text Wrap 

Page 138: While this exercise has students wrap text 
around an irregularly shaped polygon, you will most 
frequently use the second button in the Text Wrap panel 
to wrap around the bounding box of an object. Text wrap 
does not require an object to be positioned above an 
object, and applies to text regardless of the layer on which 
an object is placed. 

Aligning 

Page 146: Students (us included) tend to forget to 
check the new align to menu and just click the align 
option. Make sure that the Align to Page or Align to 
Selection is selected when performing these alignment 
operations.

Select within a group

Page 148: There are other ways to select within a 
group. Another method is to double-click on a group 
of objects with the Selection tool. The Direct Selection 
tool is chosen and you can click on any of the objects 
independently within the group.

Questions 

What are the differences between the Selection and 1. 
Direct Selection tools? 

Why should you use the text inset command?2. 

Name two ways to fit a frame to it’s contents.3. 

Answers 

The direct select tool is used to select individual 1. 
anchor points, line segments and the content of 

picture frames. Use the selection tool to manipulate 
an entire frame. 

Use the text inset when you have a border around the 2. 
edge of a text frame or if a text frame has a colored 
background. This provides for distance between the 
edge of the frame and the location of the text within 
the frame.

By double-clicking on a frame handle or choosing an 3. 
Object > Fitting command.
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Lesson 4: Importing and Editing Text
Because most InDesign documents include text and 
graphics that are created using other programs, you 
should become familiar with the process of importing 
text. 

Missing Fonts 

Page 154: InDesign provides a number of additional 
ways to indicate that fonts are missing. The listing of a 
missing font in the Character panel is provided inside of 
brackets, a Missing listing is added to the Font command 
under the Type menu and fonts are also highlighted 
in pink when displayed in the layout. There should 
be no mistaking missing fonts in your documents. To 
avoid missing fonts, use the Package command when 
assembling a document for delivery to a print service 
provider or confirm that the person with whom you are 
sharing the document has the necessary fonts. Fonts are 
software, and they should only be installed within the 
rules outlined in the licensing agreements. 
 
Remind students that the pink highlighting will not 
appear when looking at a layout in Preview mode.

Creating Text Frames 

Page 157: Pay close attention to the cursor icon when 
creating text frames. The square icon surrounding the 
cursor indicates that a box will be created when you click. 
If only the I-beam is visible, then the cursor will create an 
insertion point in an already existing frame. 

Flowing Text

Pages 159–161: One of the most common tasks is 
to import text and flow it from one page to another. Be 

certain that students understand automatic flowing of text 
so that they can import larger passages of type without 
having to manually add each page in the document. Also 
remind students that if they misplace or replace text when 
placing or threading that Edit > Undo will work wonders.

Styles

Pages 161–163: This section provides a quick 
overview of the benefits of using styles to apply multiple 
formats to type in a single step. Lesson 7 covers styles in 
greater depth. 

Adding a Page Continuation Note 

Pages 166–167: These jump lines can be fussy. Make 
sure that there is no text wrap turned on for any objects 
that the text jump line frame comes near. Also, make sure 
that students fully touch the two frames to get the next 
page number to work.

Columns 

Page 170: As a variation, you can create one box and 
divide it into multiple columns using the Number of 
Columns command in the Control panel. It is often easier 
to create one box and divide it into multiple columns as 
opposed to creating separate, linked boxes.

Finding and Changing

Page 174: The new Find/Change capabilities can be 
overwhelming. Make sure that students focus on what 
it is they are attempting to find. Also make sure that 
students clear the formatting they were looking for in the 
Find/Change dialog box when they are done by clicking 
on the Clear Specified Attributes button. It’s a good habit 
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to get into since it is remembered for the next search.

Checking Spelling Dynamically

Page 179: Tell students that they can turn this feature 
on and off, depending on if they need it at that moment.

Using the Story Editor 

Page 182: The Story Editor may be useful for students 
producing documents that include a great deal of linked 
text. The Story Editor makes it much easier to work with 
longer sections of text. 

Questions 

How can you spell check all the text in a document? 1. 

Name two ways that you can turn a single column 2. 
text frame into a multiple column text frame? 

What is the difference between a character style and a 3. 
paragraph style? 

Answers 

You can choose the Document option in the Check 1. 
Spelling dialog box (accessed from the Edit menu). 

Either by choosing Object > Text Frame Options 2. 
or by accessing the Number of Columns box in the 
Control panel.

Paragraph styles apply to an entire paragraph, while 3. 
Character styles only apply to text that is selected. 
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Lesson 5: Working with Typography
This chapter provides an introduction to many of 
InDesign’s more refined typographical features such as 
kerning, tracking, and drop caps. 

Baseline Grid 

Pages 189–192: Because the both the baseline grid 
and leading control the amount of space between lines, 
you need to work with both options when using the 
baseline grid. You can set leading values to be equal to 
or less than the baseline grid option, otherwise type may 
skip to the next grid line, which may provide too much 
space between the lines. 

Space Above and Below Paragraphs

Pages 192–194: New students frequently use extra 
paragraph returns to add spaces between lines, or try 
unusual techniques to increase line spacing. The Space 
Before and Space After options are the most consistent 
methods for adding space between two paragraphs. 
You can also use the Leading options for adjusting line 
spacing. Additionally, you can use the baseline grid to set 
the line spacing. All of these can be used with paragraph 
styles, making it easy to make changes to multiple 
paragraphs in a single step. 

Creating a Drop Cap

Page 199: Many users do not realize that Drop Caps 
are a paragraph attribute, and thus do not require you to 
select the characters you wish to use. Because of this, you 
can also use them in paragraph styles. 

Adjusting Letter and Word Spacing 

Pages 202–203: Changing the kerning and tracking 

of headlines and larger type is often necessary. Make 
certain that your students understand the difference 
between kerning, which controls the space between 
character pairs, and tracking, which controls the space 
between multiple characters. 

Working with Tabs 

Page 205: You can also prepare your students for tables 
(Lesson 8) as you discuss tabs. Tabs and tables are two 
methods for presenting complex text information. Tabs 
can be tricky for new students. It’s best to lay the ground 
work by defining what a tab stop is.

Questions 

How can you easily apply a drop cap to all of the 1. 
first characters used in multiple stories across a 
document? 

If type is ignoring the baseline grid, how can you 2. 
correct this situation? 

Answers 

You can create a Paragraph style and apply it to the 1. 
first paragraphs where you want the drop cap to 
appear. 

You may simply need to apply the baseline grid to 2. 
the type from the Paragraph panel. But if the type 
has been told to align to the grid and it is working 
inconsistently, there is probably a leading value, a 
space before or a space after that is causing the text 
to not use the grid for alignment. Reduce or remove 
these values to have the grid work appropriately.
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Lesson 6: Working with Color
This lesson provides a more detailed look at the methods 
for creating, saving and applying colors. Students may 
note that colors on screen are not necessarily consistent 
between computer monitors and printed output, which is 
addressed in the second portion of this chapter. 

Saving Color 

Page 218: The process is quite similar whether you 
are mixing CMYK colors, or saving spot colors, such as a 
PANTONE color. Encourage students to work primarily 
in the Swatches panel, as it provides one central location 
for creating, saving, applying, and modifying colors. 

Creating Dashed Strokes

Pages 222–223: While InDesign provides a great 
many stroke choices, you can also create customized 
stroke types by choosing Stroke Styles from the Stroke 
panel menu. These styles then become available in the 
Type drop-down menu in the Stroke panel. 

Creating and Applying a Gradient 
Swatch

Page 224: You may want to have more advanced users 
create gradients with more than one color. You can click 
on the bottom of a gradient ramp, between the two stop 
colors to add an additional stop color. You can then 
change the additional color to meet your needs. This is 
covered in detail on page 234. 

Applying Color to Text 

Page 231: Be careful when you first attempt to apply 
colors to text, as InDesign provides a number of options. 
You can apply color to the text fill or the stroke, just 

as you can with frames. And if you have a text frame 
selected, you need to use the controls in the Swatches 
panel to direct InDesign to colorize the text and not the 
frame.

Dragging a Color to Apply to Text

Page 232: Make sure that students are careful when 
dragging colors out onto objects. If they miss, other 
things may be colorized.

Ensuring Consistent Color 

Page 237: The implementation of color management 
has changed since earlier versions of InDesign (but very 
similar to CS2), so even if you are familiar with color 
management concepts, you may wish to review this 
chapter.

Working Spaces 

Page 244: Working spaces may vary if students are 
using different computers or if they are using different 
printers for proofing. 

File Formats and Profiles 

Pages 247-249: Not all image file format support 
embedded profiles. Some that do support profiles include 
.psd, .ai, .tif and .jpg. 

Questions 

How can you edit the name or attributes of a color 1. 
swatch? 

How do you create a new color swatch? 2. 
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How can you change a spot color to a process color? 3. 

What is the difference between color management 4. 
and color correction? 

What is a profile? 5. 

Answers 

You can double-click on a color swatch to edit its 1. 
name and attributes. Be careful that you do not have 
an object selected when you do this, as you may apply 
the color to the object at the time you click the swatch 
to edit it. 

You can click the New Color Swatch button or choose 2. 
New Color Swatch from the Swatches panel menu. 

You can edit the swatch and change it to a Process 3. 
color and change its Color Mode to CMYK and its 
Color Type to Process. 

Color management helps you to achieve more 4. 
consistent color, while color correction is used to fix 
color related problems. 

A profile is used to identify the characteristics of a 5. 
device – such as a scanner, a monitor or an output 
device. The profiles are used by InDesign to render 
an image so that when it is viewed on screen or on a 
proof it more closely resembles the final product.
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Lesson 7: Working with Styles
Styles are a critical feature for any document that uses 
repetitive formatting, especially longer documents. 
Too often styles are under utilized by students, and you 
should encourage your students to gain a firm grasp of 
the concepts and features for character, paragraph, and 
object styles. Also, it is important to distinguish early on 
between paragraph and character styles and what each is 
used for.

Creating a Paragraph Style

Page 267: Make students aware that they do not have 
to select text in order to apply a paragraph style.

Character Styles 

Page 271: Character Styles serve as the foundation 
for text styles. Character Styles can be used for the easy 
application of multiple attributes–like font, size, and 
style. You can also create a character style to easily apply 
a single attribute - like Bold or Italic. When creating a 
Character Style, any formatting attribute not explicitly 
identified in the New Character Style window will remain 
as-is after the application of the style. So a single style that 
applies the Bold attribute can be used to create Minion 
Pro Bold and also Adobe Garamond Pro Bold (providing 
that both of these fonts are installed). 

Nested Styles 

Pages 277–280: If your paragraphs always start 
with a certain formatting pattern, you can combine 
character and paragraph styles together to build a nested 
style. Nested Styles allow you to automatically style the 
first several words or characters of a paragraph using a 
character style, then format the remaining portion of a 

paragraph using a paragraph style. The formatting occurs 
in a single click. If your students are advanced, you may 
want to have them add multiple character styles as a 
nested style. 

Creating an Object Style

Pages 281–284: Object styles allow users to save 
formatting applied to frames - including formatting 
applied to text inside of a frame. Notice in CS3 that the 
Effects are now added to the object style formatting 
options. Allow students to select Preview in the New 
Object Style dialog box and try other effects.

Table and Cell Styles 

Page 286–291: Table and cell styles, which are new in 
CS3, allow users to save formatting applied to tables and 
cells - including formatting applied to text inside of a cell.

Globally Updating Styles 

Page 291: You can update character, paragraph, object, 
table and cell styles using the same technique. 

Loading Styles From Another Document

Page 293: If you’ve already created styles in another 
document, you can import them into another InDesign 
file using the Load command from the panel menu. 

Questions 

How do character styles differ from paragraph styles? 1. 

When applying a character style, what steps are 2. 
necessary, and how does this differ from applying a 
paragraph style?
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What two types of styles are involved in creating a 3. 
nested style?

Answers 

Character styles include only character attributes 1. 
(font, size, color, scaling, kerning, etc.)–the attributes 
that are located in the Character panel and not those 
located in the Paragraph panel 

When applying a character style you must first 2. 
highlight the text to be formatted. Only the 
highlighted text is styled when applying a character 
style. Alternatively, paragraph styles apply formatting 
to an entire paragraph, even if  the cursor is only 
inserted in the paragraph. No text needs to be 
highlighted when applying a paragraph style. 

A paragraph style and a character style.3. 
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Lesson 8: Importing and Linking Graphics
By default InDesign links to graphic files that are placed 
in an InDesign layout. This lesson provides a foundation 
for managing imported graphics using the Links panel 
and also using the Library for handling frequently used 
objects. 

Missing and Modified Images 

Pages 301-305: The Links panel shows all objects 
that have been imported into a file that might be 
needed for printing. Watch for yellow triangles, which 
indicate images that may have changed since the time 
they were imported and red stop signs, which indicate 
that InDesign can no longer locate the image that was 
imported. A file should not be printed or exported if 
it has missing or modified images. By default, text files 
are not listed here, as they are not needed for printing. 
However, you can change this option. Also, be on the 
lookout for an eye icon in the Links panel. This indicates 
that a linked object has had it’s layer options changed. 
 
A nice shortcut for Go to Link is to Alt (Windows) or 
Option (Mac OS)-double-click on a link name.

Adjusting View Quality 

Page 305: The Typical setting is the best option 
unless you have a need to see the original, high-quality 
artwork. When you are done viewing artwork at a higher 
resolution, you can set it back to the Typical mode. 
 
Caution students about working in High Quality mode all 
of the time as it may impact running performance.

Working with Clipping Paths 

Pages 306-309: You can also use work paths, clipping 
paths and alpha channels – all built into a graphic-  to 
define the visible portion of an image. Caution students 
against using the built–in clipping path option in 
InDesign for every image that requires one. Photoshop 
is still the best option for most objects that require a 
clipping path.

Working with Alpha Channels 

Page 309-315: This section requires the use of 
Photoshop. If you are teaching a class focused on 
typography, you may want this section to be optional. 
The features discussed in this section are good for users 
to understand, as the image preparation in Photoshop 
impacts the ability to display a silhouette within 
InDesign. 

File Formats 

Page 316, 320: While we work with .psd, .ai and 
.pdf files in this lesson, you can use virtually any file 
format. InDesign supports formats such as TIFF, EPS and 
JPEG, to name a few. The native file formats offer some 
advantages, such as the ability to work with a Photoshop 
file that includes layers.

Creating a Library

Page 325: As stated in the book, caution students 
about image linking in the library. A way around that is to 
embed the image in the Links panel, then drag a copy into 
the Library panel. It will be embedded in any document 
you later drag it into from the library.
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Questions 

Why is it important for links to graphic files to be 1. 
maintained? 

What is the benefit of a clipping path or alpha 2. 
channel? 

Answers 

Because InDesign relies on the original source file 1. 
for printing, most graphics will not print correctly 
(nor will they export correctly to PDF) if the original 
source file can not be located. 

Creating a clipping path or alpha channel lets you 2. 
save selections and determine which portions of an 
image will print. Because these are most-often created 
using an image-editing program, such as Photoshop, 
you can print the image exactly as it was intended by 
the designer or photographer. 
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Lesson 9: Creating Tables
Tables make it easier to present large amounts of data. 
Tables are created within text frames, and can be easily 
controlled through the Tables panel and the Table menu. 
You can also use the Control panel to manipulate tables. 
You can import tables from Excel and Microsoft Word, 
copy and paste a table into a layout, or you can convert 
existing text to a table. 

Importing Tables 

Page 334: You can import tables created in Microsoft 
Word or Excel directly into InDesign. You can choose 
the import options to select which Excel sheet is being 
imported and even choose a cell range or from a 
Microsoft Word document whether tables are formatted  
or are turned into text. 

Cell Attributes 

Page 338: Table cells can be formatted independent of 
the rest of the table. Individual cells are formatted using 
the Cell options. You can format all of the cells by using 
Table options. 

Table Headers 

Page 339: Tables can be linked across multiple text 
frames, and table headers appear at the top of each frame 
containing the table. You can have your more advanced 
students experiment with creating tables that span 
multiple text frames, and add table headers that appear in 
each frame.

Table Panel 

Page 342: While the Table panel provides a 
comprehensive set of options for creating and 

manipulating tables, you can also use the Control 
panel for many, but not all, of the options covered in 
this section. You may want to have your students learn 
the concepts with the Table panel and then let them 
experiment with the Control panel. 

Placing Graphics in Table Cells

Page 343: Graphics placed into a table are in-line and 
need to be copied and pasted into the cell or they are 
imported while you have a text insertion point (blinking 
cursor). 

Dragging to Adjust Column Size

Page 350–351: When dragging columns and row 
with the Type tool, holding down the Shift key will resize 
just the columns or rows affected, not the overall width or 
height of the table.

Questions 

How are graphics imported into a table? 1. 

How do you easily select an entire row, a column or 2. 
the entire table? 

How do you add or delete rows and columns? 3. 

Answers 

You can choose the Place command when the cursor 1. 
is inserted in a table cell, or you can choose the Paste 
command after copying a graphic.

You can move your mouse to the outside portion 2. 
of a row or column and click when the black arrow 
appears. You can also move your cursor to the 
upper left corner of a table and click when the arrow 
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appears to select the entire table. 

You can add or delete rows by entering a larger or 3. 
smaller number in the rows or columns section of the 
Tables panel. You can also choose the Insert or Delete 
commands from the Table panel menu.
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Lesson 10: Working with Transparency
InDesign supports transparency whether it is created 
in another program, such as an image imported from 
Photoshop, or created using InDesign.  This lesson shows 
some of the ways in which transparency can be added to 
objects using InDesign effects and transparency options. 

Colorizing Black and White Images 

Page 359: Note that you can colorize the image and 
you can also colorize the background color of the frame 
containing the image.

Layers

Layers are turned on and off throughout this lesson. Make 
sure to have students follow this closely. If they discover 
that they cannot access something in the lesson because it 
is locked or hidden, have them go to the Layers panel and 
deal with it.

Adjusting Transparency

Page 366: When using the new Effects panel in 
InDesign CS3, make sure that the correct level is chosen 
(stroke, fill, etc.).

Applying a Gradient Feather

Page 372: A gradient feather can be applied to objects 
in several ways. One of the easy ways is to select an object, 
then select the Gradient Feather tool and drag across the 
object. This will apply the effect. You can then edit the 
effect in the Effects panel. Have students experiment with 
images on the page as well.

Applying Effects to Other Objects

Page 376: Students may miss the mark when dragging 

the effect onto the other green half–circle. It’s easy to 
undo and try again.

Editing and Removing Effects

Pages 376–377: Make sure that students realize that 
by using the Clear Effects button, ALL effects are removed 
including transparency and blending modes.

Questions 

What is the advantage of applying effects using 1. 
InDesign?

Why is it important for a page-layout program to 2. 
support transparency?

Answers 

You can avoid returning to Illustrator or Photoshop 1. 
to create certain effects supported in InDesign. You 
can also create fully editable type, such as headlines, 
using drop shadows within InDesign. While you 
can achieve similar results in both Photoshop and 
Illustrator, this involves making the element and 
importing into InDesign. Any edits need to be done 
in these other programs. 

Because transparent elements can be created using 2. 
Photoshop and Illustrator, it is important that page 
layout programs understand how to handle these 
items. Images with feathered edges or pictures with 
transparent elements (such as a glass) can only be 
successfully used in a page layout program that can 
recognize transparency.
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Lesson 11: Working with Long Documents
You can use books to more easily manage long 
documents. It becomes impractical to have one document 
that is hundreds of pages in length. Using the book 
feature you can break longer documents into sections, 
and add each section to the Book panel. You can create 
multiple book files, which reference individual InDesign 
files. This chapter is focused entirely on long-document 
features of InDesign. 

Creating a Book 

Pages 382-384: The book file links to the individual 
InDesign files that have been added to the book. The 
sequence of the files in the panel is important, as it 
determines page numbering if automatic page numbering 
is being used in any of the files. You can use the 
synchronization options in the panel menu to determine 
how synchronization of the files occurs-establishing one 
document as the source for all definitions of styles and 
colors. Multiple individuals can work on various portions 
of a book at the same time, although each file can only 
be open for editing by one individual at a time. However, 
the same book panel can be opened by several users 
concurrently. 

Working with a Table of Contents 

Page 385: You can create a custom set of styles for the 
text in a table of contents before you build the TOC. This 
lets you choose the style when building the TOC, and 
have it automatically formatted. InDesign also includes 
some default TOC styles that become available when you 
create the TOC. 

Synchronizing Book Documents

Page 389: When using the synchronize feature, you 
can select several, all, or none (which applies to all) of 
the documents in a book. Also, make students aware that 
once the synchronize takes place, it’s difficult to undo.

Indexing the Book

Page 390: You can also create index topics, as opposed 
to references. Use this option to determine what will be 
in the index, and then create the references to conform 
to the topics you have added. Index topics can be shared 
between multiple InDesign documents as well.

Questions 

Are index entries automatically updated? 1. 

How do you specify that a TOC and Index will 2. 
include all chapters in a book? 

Why create a book? 3. 

Answers 

Index entries are not automatically updated. You 1. 
must add individual entries or use the add all option 
to have them added. 

You must check the box in the Index panel for it to 2. 
include book chapters. For you to include all book 
chapters in a TOC, use the checkbox in the TOC 
dialog box. 

Books make it easy to work with longer documents 3. 
and to make certain that styles and colors are defines 
consistently across multiple files. 
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Lesson 12: Output and PDF Exporting

As a page-layout program, the primary destination 
for most files will be a printed product. Whether this 
is a brochure, package design, or newsletter, you need 
to know how to print effectively and check the file for 
possible errors. A large and ever-growing number of print 
service providers accept InDesign files, and this chapter 
covers the tools for successfully printing with InDesign. 

You can also create PDF files for a variety of purposes—
including distribution online and for press printing. 

Using Preflight 

Page 401: This step is essential before handing-off a 
file. Whether you are delivering the file to a commercial 
printer or a colleague, this option confirms that all assets 
necessary for printing or editing the document are 
available. The preflight step is run automatically whenever 
you choose the Package command. 

Using Package 

Page 404: Packaging a file is also a great way to create 
an archived version of a document, as it includes all 
necessary elements. 
 
Do make students aware that every time they Package a 
file, they are creating copies of all of the linked objects. 
This can make people lazy and wind up with lots of copies 
taking up space.

PDF Quality Options 

Page 406: Note that there are a variety of settings 
that control the quality of the final PDF document. It is 
important to select a setting that matches your needs for 
the final PDF. A high quality PDF might be suitable for 

sending to a printer, but might be impractically large to 
post on-line If students have questions on the PDF/X 
file options, and you are unsure, visit the InDesign Help 
Center and search for PDF/X. 

Separation Preview 

Page 407: You can confirm the actual printing 
breakdown of a file to confirm that it is exactly as you 
intended by using the Separation Preview panel. 

Printing a Laser or Inkjet Proof

Pages 410–418: When going through this section, it 
is important that if students are not connected to a printer 
that you have them choose either PostScript file for 
Printer and a PPD besides Device Independent or they 
choose an installed print driver to see all of the options.

Questions 

How do you save your print settings? 1. 

How can you confirm what ink separations will be 2. 
printing? 

What are some of the advantages of InDesign’s 3. 
integrated PDF export? 

Are all PDF files the same quality? 4. 

Answers 

You can create a Print Preset. 1. 

You can use the Separation Preview or use the Ink 2. 
Manager. 

Because you do not need to generate PostScript files 3. 
and use Acrobat Distiller, you tend to create PDF files 
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much faster. The integrated PDF export also provides 
for enhanced PDF options, such as the inclusion 
of multimedia elements and buttons that would 
otherwise not be possible. 

You can choose from a number of preset options that 4. 
determine the quality (and file size) of the resulting 
PDF. There are high quality and low quality PDF 
options that are available, so all PDF files are not 
the same. In fact, you may need to export a PDF file 
multiple times if you intend to distribute the file on-
line and also for printing.
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Lesson 13: Using XML
Larger organizations are increasing using XML to 
repurpose the content that they create. InDesign’s 
integrated XML import and export capabilities allow 
you to either import XML that was created previously, or 
convert your document contents into XML that can be re-
used in other forms– whether print or on-line. 

This chapter covers the basics of working with InDesign’s 
XML capabilities. You may want to consider your 
audience when teaching this section as it’s contents are 
not suitable for everyone.

Importing and Applying XML Tags 

Page 427: Most XML workflow require the tagging 
of objects, and the tags must be consistent from one 
document to the next. For this reason, the tags are 
generally created once and then imported and applied to 
each document. This keeps the tag name. 

Viewing and Organizing Structure 

Page 431: Because the structure sequence indicates 
the order and relationship of the elements in the layout, 
it is important to pay close attention to the way in which 
items are listed. Recipients of the XML may not have the 
layout as a reference, so they need to clearly understand 
the relationship of items by viewing their structure in the 
XML file. 

Using XML Snippets 

Page 439:  While technically these are XML items, you 
should encourage students to take advantage of snippets 
the way they might use an object library. Snippets can be 
used with no knowledge of XML as a simple way to share 
items between documents. 

Relate to students that snippets can also be created by 
selecting objects then choosing File > Export and choose 
InDesign Snippet from the formatting menu. They can 
also be placed by choosing File > Place.

Questions 

Why export XML? 1. 

Do designers generally create their own XML tags? 2. 

Answers 

XML provides a format for sharing document content 1. 
so it can be reused in other formats. The exported 
XML is independent of the layout, so it is important 
for the structure and tags to accurately reflect the 
layout. 

Tags are generally created once and then imported, 2. 
this keeps the tags consistent between documents. 


